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Safety Information

IMPORTANT! Proper care in handling should be taken when using any precision optical test
equipment. Scratched or contaminated optical connectors can impact the performance of the instrument.

NOTE! FOCIS Flex contains no user serviceable parts. This instrument must be returned to AFL or
authorized agents for repair.

IMPORTANT! It is important to keep connector end-faces on the launch and receive cables and those
on the Fiber Under Test (FUT) clean, to ensure accurate measurements and operation.

CAUTION! Never view a live fiber. Never look directly into the optical outputs of fiber optic network
equipment, test equipment, patch cords and jumpers. Laser radiation is harmful to eyes.

WARNING! Use only the specified AC adapter. Use of another type of AC adapter can damage the
instrument and create the danger of fire and electrical shock.

WARNING! To avoid the danger of fire and electrical shock:

« Never use a voltage that is different from that for which the AC adapter is rated.
« Do not plug the unit into a power outlet that is shared by other devices.

« Never modify the power cord or excessively bend, twist, or pull it.

Do not allow the power cord to become damaged. Do not place heavy objects on the power cord or
expose it to heat.

Never touch the AC adapter while your hands are wet.

Should the power cord become seriously damaged (internal wiring exposed or shorted), contact the
manufacturer to request servicing.

NOTE! Refer to your company’s safety procedures when working with optical systems.

NOTE! Follow your company’s approved cleaning procedures.



General Information

How to View Device Information Menu Single 3 15:34 WY

« From the Live Image mode (&), press the Main Menu
key to access the Main Menu screen.

« Press Up/Down % arrow keys to navigate and highlight
the Device Info menu (©).

» Press Select () or Right » arrow key to display a sub-
screen of the Device Info menu, which will display the

following Info:
— Device name )
'
— Serial number % seteos ;
— Controller version number (CJ ResutsManzger >
— User Interface version Number Last Image >
« Press Back (E) soft key to return to Live Image mode. @)‘> i U

Note: It is helpful to have your FOCIS Flex Device
Information available if you need to contact AFL Test &

Inspection Customer Service or Technical Support. ® CI?

Warranty Terms and Conditions

AFL Test and Inspection products are warranted against defective material and workmanship for a period
of (1) one year from the date of delivery to the end user. Optional Extended Warranty starts at the end

of the standard (1) one year warranty period. Any product that is found defective within the warranty
period, will (at the discretion of AFL) be repaired or replaced. Warranty will be voided if the product has
been repaired or altered by other than an authorized AFL repair facility or when it has been subjected to
misuse, negligence, or accident.

In no case shall AFL liabilities exceed the original purchase price.

Repair Services

Please contact customer service for a return authorization number prior to sending your AFL test
equipment in for repair or calibration.

USA Repair and Calibration services Europe Repair and Calibration services
AFL Test & Inspection Division Fujikura Europe Ltd.

16 Eastgate Park Road C51 Barwell Business Park

Belmont, NH 03220 Leatherhead Road

603-528-7780 Chessington, Surrey, KT9 2NY
800-321-5298 +44 (0) 208 240 2020

Standards Compliance Information

FOCIS Flex has been designed and tested to comply with the relevant sections of any applicable
specifications including full compliance with all essential requirements of the applicable EU Directives.

2002/95:EC




FOCIS Flex Overview

Controls, Display, Interfaces

Controls

(@) Power key - o

@ Image Capture key - (O]
@ F1 soft key (typically Back function)

@) F2 soft key (typically Select function)
(®) Navigation and Edit functional keys

Display (2-inch Color LCD [320 x 240])
(®) Screen title

(@) Battery status icon

Image and information display area
@ F1and F2 soft key labels area

Interfaces

(o), Optical inspection port
@1). Adapter tip

@2). Dust cover

@3). Micro-USB port

@4}. 5 VDC input jack
@5). Charging indicator

@ Resuits Manager

Last Image
o Device Info




FOCIS Flex Overview

Properly Installing and Removing Adapter Tips

FOCIS Flex is available with the following adapter tips:

Connector UPC Connectors APC Connectors
Ferrule Bulkhead o Ferrule Bulkhead
SC FFLX-01-U25 FFLX-01-SC FFLX-01-A25 FFLX-01-ASC
FC FFLX-01-U25 FFLX-01-FC FFLX-01-A25 FFLX-01-AFC
LC FFLX-01-U125 FFLX-01-LC FFLX-01-A125 FFLX-01-ALC
ST FFLX-01-U25 FFLX-01-ST Not applicable Not applicable

Note: Contact AFL Sales Representative or Tech Support for additional
connector adapter tips
Installing Adapter Tips

« While holding adapter tip in place, raise captive nut (&) until it engages
with adapter tip threads.

« Turn captive nut counter-clockwise (viewed from front/top).
« Hand-tighten (do not over-tighten).

Removing Adapter Tips
Probe tips are held in place with a captive nut (&).

e Turn captive nut clockwise (viewed from
front/top).

« Continue until captive nut is free of adapter tip.
 Remove adapter tip by pulling it gently straight off the probe base.

Note: For proper viewing, APC connectors must be aligned with the slot
in the threaded area of the correct APC adapter tip.

Identifying Connector Adapter Tips

 FOCIS Flex adapter tips are engraved to AFL NO. Engraved | Description
indicate connector type and application. D
 FOCIS Flex adapter tips are shipped in FFLX-01-SC SC SC-UPC, Bulkhead
labeled containers. Labels indicate: FFLX-01-FC FC FC-UPC Bulkhead
— AFL part number. FFLX-01-ST | ST ST-UPC, Bulkhead
~ Connector type, ferrule type (UPC or FFLX-01-LC | LC LC-UPC, Bulkhead
APC), application. FFLX-01-U25 | U25 2.5 mm, UPC, Ferrule
+ Blue ring on the adapter tip base FFLX-01-U125 | U125 1.25 mm, UPC, Ferrule
indicates tip for UPC polished connector. FFLX-01-ASC | ASC SC.APC. Bulkhead
* Green ring on the adapter tip base FFLX-01-AFC | AFC FC-APC, Bulkhead
|nd!cates an adapter tip for angle- FFLX-01-ALC | ALC LC-APC, Bulkhead
polished (APC) connector. FFLX-01-A25 | A25 2.5 mm, APC, Ferrule
FFLX-01-A125 | A125 1.25 mm, APC, Ferrule




Getting Started

Power-Up
« Press and release the Power key (&).
Power-Down

« Press and hold the Power key (&) until display

Configure FOCIS Flex to Auto-Off

- AC connected; charging, not fully charged
[mmm] - AC connected; charging, fully charged

Powering Up/Down

turns off.

From the Main Menu -> Settings, select Display &
Power Save option.

Select desired power save option: 2 min, 5 min,
10 min, Never.

Battery Charging and Operation

Plug the included AC Charger into AC outlet.
Connect charger plug into 5 VDC jack (B) on FOCIS Flex.
LED (©) indicates charging status as follows:

— OFF - AC not connected

— RED - Charging battery

— GREEN - Fully charged

— RED/GREEN flashing - Charging error. Verify correct
5VDC 2A charger is used. Allow to cool before charging.

FOCIS Flex charges while operating.
Battery icon (D) indicates battery state as follows:

{§}Setﬁngs
[mm] - Battery operation, fully charged (9 Resuits Manager
] - Battery operation, partially charged ;t:":f

[ - <15 min Battery operating time remaining




Getting Started

Live Image Mode Features

FOCIS Flex powers-up in the Live Image mode.

Pressing and holding the Help 2 soft key (&) displays help tips about FOCIS
Flex keys usage. Note: pressing the Left € arrow key toggles between
connector types:

— Single (single fiber connector, UPC or APC)

— MPO-PC/APC (MPO/MTP® multi-fiber connector; PC or APC finish)

— MPO-Flat (MPO/MTP multi-fiber connector; Flat finish [rare])
Pressing the Menu = soft key (B) displays the Main Menu that allows the

user to set preferences, perform general settings, manage saved test results
and perform other non-test functions. 3% sertings @ N
« Pressing Menu > Setting (C)> Capture (D) displays the Capture settings () ResultsManager >
menu. Last Image >
« When the Auto Focus option is enabled () in the Capture screen and @ oovicernio
Capture key [O] is pressed:
— Auto focus is initiated ——
. Capture >
— Image is captured when auto focus completes i

Pass/Fail on
— Image is analyzed if Pass/Fail set to On

Display and Power Save >

— FOCIS Flex transitions to Captured Image mode Beeper @)
 When Auto Focus is enabled or disabled: . e

— Press Right > arrow key to auto focus once Auto Focus @»()

— Press Up/Down w a arrow keys to manually adjust focus Auto-Save  On Ist Capture

Save to Folder/File >

« When the Auto Focus option is disabled (F) in the Setting screen and
Capture key [O] is pressed:

— Image is captured (without adjusting focus) P — @,@

y

— Image is analyzed if Pass/Fail set to On Auto-Save  On lst Capture

— FOCIS Flex transitions to Captured Image mode

Capture Key Operation

« In the Live Image mode, press the Capture key [O] to perform the following:
— Auto Focus image (if the Auto Focus option is enabled)
— Capture the displayed image and enter the Captured Image mode
— Analyze image (if the Pass/Fail option is enabled)

« In Captured Image mode, press the Capture key to return to Live Image mode.

« In the Main Menu or Settings modes, press the Capture key to return to the most recent Live or
Captured Image mode.



Getting Started

Captured Image Mode Features

Once an end-face image has been captured and analyzed, a zoomed-out view of the end-face and
results is displayed.

# Description

@) ScreenTitle: displays File Name (e.g. CO01-003) if saved image is shown
or Captured @ hh:mm:ss if unsaved image is shown.

@ Pass/Fail Indication: shown only if Pass/Fail option is enabled in Settings.
() Display Tabs: select the desired view using the Left/Right <» arrow keys.
@) End-face Image: displays end-face image with Pass/Fail overlay (if enabled).
(8) Back soft key: press to return to previous screen.
® Image Layers soft key: use Up/Down ‘% keys to view image layers as follows,
« End-face image with overlay layer shown (default view)
« End-face image only
« Overlay only
@ Menu= soft key: press to display the Save/Send Menu.

Captured @ 16:33:49
[+] [¢] [* [J- Zoomed Outlmagfe

[o] - Partially Zoomed Tn

Image
O Fuﬂy Zoomed In Image
B pass/Fail Results Table
i- Image Information

Passing scratches/defects
highlighted in GREEN

Failing scratches/defects
highlighted in RED

@

Zoomed in end-face image with Overlay



Getting Started

Pass/Fail Results Table

# Description

(@) Screen Title: displays File Name (e.g. C001-003) if saved image is shown or Captured @ hh:mm:ss
if unsaved image is shown.

@ Pass/Fail Indication: shown only if Pass/Fail option is enabled in Settings.

(3 Display Tabs with the Pass/Fail display tab selected.

@) Analysis Rule applied to determine Pass/Fail.

(® Analysis Zones: A - core, B - cladding, C - adhesive, D - contact area.

(®) Scratch analysis results for each zone:
« Reports the number of detected scratches exceeding limit for each region
« Highlights failed rules in RED

@) Defect analysis results for each zone:
« Reports the number of detected defects exceeding limit for each region
« Highlights failed rules in RED

Back soft key: press to return to previous screen.

(@ Menu soft key: press to display the Save/Send Menu.

Note: See section “Setting Pass/Fail Criteria” on page 14 for details on how to select and/or edit
pass/fail analysis rules.




Getting Started

Image Information Screen

# Description

@) ScreenTitle: displays File Name as follws,
« <Cable>-<Fiber> (e.g. CO01-003) if saved image is shown.
« 'Captured @ hh:mm:ss’ if unsaved image is shown.
@ Pass/Fail Indication: shown only if Pass/Fail option is enabled in Settings.
@ Display Tabs with the Image Information display tab selected.
@) Results ID field: indicates default folder/file names.
« Blue highlighted indicates that results are not saved.
(8 Time & Date field: indicates Time & Date of the displayed captured image.
(®) Rule field: indicates pass/fail analysis rule applied.
@) Back soft key: press to return to previous screen.
Menu soft key: press to display the Save/Send Menu.

1 el (0
2 [ [ @ B if—@
Job: MTP000000000 *
O Scope End: END100 *
Far End: END200 *
Cable: coo1*
Pair Mode: None *
Pair Type: None *
Fiber: 017 *
E&——{ Time: 2016.12.21 16:33:49 |
Rule IEC 61300-3-35
: PC, SM, ORL = 45 dB
D —

! !

Note: See section "Saving Captured Images” on page 18 for details on how to name and save results.




Main Menu and Settings

Main Menu Overview

Main Menu

The Main Menu is accessed from Live Image mode by pressing the Menu = soft key. Main Menu is used
to select user preferences, perform general settings, manage saved test results, and perform other non-
test functions.

While in the Main Menu:

« Press Up/Down % arrow keys to navigate and select
(highlight) one of the menu item as follows. {é’} Settings >

- Sgttllngs: Use to configure Auto Fqcus, Pass/Fail ﬁ Results Manager R
criteria, Bluetooth, and general settings

— Results Manager: Use to navigate and review Last Image >
or send saved test results o Device Info

— Last Image: Use to recall most recently
viewed image

— Device Info: Use to view serial number, software
revision, etc

o Press Select (&) or Right » arrow key to display a
sub-screen of the selected menu item 9 Select

o Press Back (B) soft key to return to Live Image mode Q o

Settings Menu Overview

While in the Settings Menu:

1 ings ——r—
« Press Up/Down % arrow keys to navigate and SERLT .

select (highlight) the desired menu item. Capture >
» For Beeper settings:

Pass/Fail On

— Pressing Select soft key toggles setting ]
between enable/disable. Display and Power Save >
— Pressing Right » arrow key enables setting. Beeper @),
— Pressing Left 4 arrow key disables setting. Time & Date N

For all other settings, press Select soft key or ]
Right » arrow key to display a sub-menu and edit Lengregs English
the selected parameter.

Press Back soft key to return to the previous

menu screen. 2] Select

Press Capture Key to return to live image mode.



Main Menu and Settings

IEC Pass/Fail Analysis

IEC 61300-3-35 defines connector inspection pass/fail criteria.
Pass/Fail criteria depends on: Passing
« Fiber type (SMF or MMF) Defect

« Connector end face regions Failing
— Aregion: Core Defect
— Bregion: Cladding Core
— Cregion: Adhesive (between cladding

and ferrule) Cladding

— D region: Physical contact area .

« Type of end face flaw: Adhesive
— Scratches Contact

— Defects (contamination, particles, chips)
e Size of flaw

Example IEC Rule

Shown below is the display when the IEC rule for single-mode PC connector with return loss > 45 dB is
selected. The table identifies the number of scratches or defects of a certain size, which may be allowed
in each of the core, cladding, and contact regions.

Region Scratch Defect IEC Rules 0y B
>0 pm: 0 >0 pm: 0 Rule IEC 61300-3-35

A: Core No scratches >0 pm No defects >0 pm Pc: = ORI;H‘_‘% i
allowed allowed &

>3 um: 0 2-5pm: 5
No scratches >3 ym | Up to 5 defects 2-5 pm
allowed diameter allowed B

B: Cladding >5 um: 0 2-5pm: 5

=>0pm: 0| >0 pm: 0

No defects >3 pm >3pm: 0 |>spm: 0

allowed
Blank Blank =
C:Adhesive | (No limitations on (No limitations on 0um 0
scratches) scratches)
Blank 0>10pm
D: Contact No limitations on No defects = 10 um
scratches allowed




Main Menu and Settings

Setting Pass/Fail Criteria

Pass/Fail menu is accessed from the Live Image mode > Main Menu > Settings.
Enable/disable Auto Analysis

» Highlight Auto Analysis (&).

o Use Select key (B) to enable/disable @D/ Pass/Fail analysis.

Change Rule:

« Highlight Change Rule (C).

» Press Select or Right > arrow key to display a list of the available Rules (D).
« Use Up/Down % arrow keys to highlight the desired Rule group ®).

» Press Select or Right > arrow key to display a sub-list (F).

« Use Up/Down % arrow keys to highlight the desired rule.

» Press Use (G) to apply the selected Rule in Pass/Fail analysis.

Pass/Fail 10:42 B Pass/Fail 10y B IECRules 10:44 BN

Auto Analysis 4———6"@ @IEC Rules 4/@ @ PC,5M,ORL Z45dB | >

Change Rule %@ OUser Rules > O APC,5M >

View Rule > OIPC Rules > O PC,SM,ORL=26dB | »
OAT&T Rules > O PC, MM >

o) /P

Current Rule: @/ \rJ

IEC 61300-3-35

PC,SM, ORL = 45 dB

9 Select )
View Rule

« Highlight View Rule ().
o Press Select or Right » arrow key to view details for the current rule.
o User Rules may be edited while viewing.

Pass/Fail 10:42 B IEC Rules
: Rule

Auto Analysis O

Change Rule >

iew Rule \@ >

Current Rule:

IEC 61300-3-35

PC,5M, ORL =45dB



Main Menu and Settings

Setting Pass/Fail Criteria

Edit User Rule:

Highlight the Change Rule option (&).

Press Select or Right » arrow key to display a list of Rules sub-screen (B).
Highlight the User Rules group.

Press Select to display a list of User Rules (C).

« Use Up/Down % arrow keys to highlight the desired rule to edit.

Press the Right » arrow key to view details screen for currently selected rule.

While in the Rule details screen (D), use arrow keys to highlight the desired Region and Scratches/
Defects parameter.

Press Select to display the Limits Editor screen (E).
Use Left/Right 4» arrow keys to select a digit.

« Use Up/Down % arrow keys to change the value.
« Press Ok (F) to confirm changes.

Pass/Fail 0 104y B User Rules G 1044
Auto Analysis c @ IEC Rules > @ PC,5M,ORL=45dB >
Change Rule > OUser Rules > O APC, SM >
View Rule > O IPC Rules > O PC,SM,ORL=26dB >

OAT&T Rules > O PC, MM >

Current Rule:
IEC 61300-3-35
PC, SM, ORL = 45 dB

LD seiect | o) Use

User Rules 0 10:46
Rule User

PC, SM, ORL = 45 dB

ABE| = e 8,
/’/ — Zone A

>0 pm: 0 | =0 pm: L1}
Defect Limits

A

@ 29l <Opm:3

=Fpm: 0| >5pm: O

D
o =0pm: 0
BT (P




Main Menu and Settings

Configuring Auto-Save

@ From the Main Menu, select Settings > Capture > Auto Focus
« Use 4> to enable or disable the auto-focus option @/ as needed.

Settings
{:é} Settings ﬁ_®— Capture > _®_> Auto Focus [ @)
@ Results Manager > Pass/Fail on Auto-Save  On 1st Capture

Last Image > Display and Power Save > Save to Folder/File >
o Device Info Beeper Q\

Time & Date >

Language English

@ Highlight and Select Auto-Save. Use wa to disable auto-send, enable on 1st Capture key, or enable
on 2nd Capture key.

() Highlight and select Save to Folder/File. Use wa to select and edit the desired folder/file field.

When Auto-Save is enabled, press Capture from Live Image mode to auto-focus (if enabled), capture
image, analyze pass/fail (if enabled), then send image and pass/fail results to paired device and save
image and pass/fail results to configured Job/Cable folder.

Note: If Auto-Save on 2nd Capture key is enabled, you will be prompted to press the Capture key again
to save or send. Press the Back key if you do not wish to save or send image.

Auto-Send

Auto Focus () U Off

Auto-Save  On 1st Capture <—®—> @On 1st Capture Key

Save to Folder/File > OOn 2nd Capture Key

Auto Focus ()

Auto-Save  On lst Capture

Save to Folder/File > Job: JoB000DODOOOD >
Scope End: END100 >
Far Endl: END200 >
Cable: cont>
Pair Mode: Cleaning >
Pair Type: Before >
Fiber: o>



Main Menu and Settings

Power Save Setting

Select desired Power Save Setting

From the Main Menu > Settings, highlight and select the Power Save (&) option to display the Power
Save settings menu . From the displayed Power Save menu, you may perform the following settings:
« Highlight and select the Auto Off option (€)

— From the displayed Auto Off sub-menu (D), highlight and select the desired time option.
« Highlight and select Brightness (E)

— Use Up/Down % arrow keys to increase or decrease the brightness

— Note: dimmer display extends battery life
« Highlight and select the Auto dim option (F). From the displayed sub-menu (G):

— Select Auto dim; use Left/Right 4» arrow keys to enable/disable auto-dimming

— Select Delay, use Up/Down % arrow keys to increase / decrease auto dim time

Settings - ) Power Save e 1045 B! Auto Off Q 0:47 B Auto dim G =]
Capture > - Auto OFf 10 min OZ min Auto dim O
Pass/Fail on Brightness He%—-@ O5 min Delay 30s
Display and Power Save 4—@ ®_. Auto dim On @10 min
Beeper @ Onever
Time & Date >
Language English

S Seect

Set Time and Date

Highlight Time & Date (H).
Use Select or Right > arrow key to display the Time/Date setup menu (7).
Use Left/Right 4> arrow keys to select the desired time/date field to edit.

Use Up/Down % arrow keys to change the selected value.

Press OK to confirm time/date settings and return to the Settings screen.

Settings 1701 Settings 7:20
AutoFocus o)
Pass/Fail Oon> )

Time Setup
Bluetooth an>

Power Save Smin> 17:20 2014.05.21
Beeper [ @)

Time & Date 4—)-—®

Language >

—— 0 s ()




Saving Captured Images

Saving to the Current Folder

« While in the Captured Image mode, press the Menu = soft key to
display the Save/Send screen. = -—Q)
. . . Send
» Highlight Save (&) and press Select soft key to save image and Esisting folders
results to the current folder. PP
Cable: Co01>
Pair Mode: Cleaning>
Pair Type: Before>
Fiber: 001>

Saving to a Newly Created Folder
New Job, Cable End, Cable, or Fiber names are created by editing an existing file name.

To edit a file name

« While in the Save/Send screen, using Up/Down wa keys, navigate to
the desired parameter: Job, Cable End, Cable, Pair Mode, Pair Type,
or Fiber.

» Press Select or Right » arrow key to display Editor (B).
* Use «» wa arrow keys to edit text field (C).

» Press Ok (D) soft key to save new name .

Note: this will make the newly created Job, Cable End, Cable, or Fiber current.

Saving to an Existing Folder

« Highlight the Existing folders (E) option.
o Press Select or Right » arrow key to display a list of existing folders.
« Use Up/Down 4 arrow keys to select desired Job folder ®.
o Press Right » arrow key to open selected Job folder.
— Repeat for desired Cable folder and Fiber number as needed.
« Press Use soft key (G) to confirm selection.
« When back in the Save/Send screen, highlight Save () and press Select.

C001-001

Jobs(2) 9990 free

Open )
Save (") JOBOO0O0000D <..-® Save)
Send (*J JOBOOOODOODT Send
Existing folders —@
Job: JOB00000000O0 > Job: JOBO0000000O >
Cable End ENDI00-END200 > Cable End END100-END200 >
Cable: 001> Cable: 001>
Pair Mode: Cleaning> Sobr Pair Mode: Cleaning >
Pair Type: Before> ScopeEnd: Pair Type: Before>

Fiber: 001> Far End: Fiber:
Cable:

C001-001

Existing folders

Select




Configuring Image Pairing

Image Pairing functionality allows user to capture and save two images for each fiber.

Available Pairing Modes and Pairing Types

Pairing Mode | Pairing Type

None None — Image pairing disabled

Cleaning Before — image before connector cleaned
After — image after connector cleaned

Input / Output | Input — network input connector image
Output — network output connector image

Documenta- As built —image of connector when network built

tion As found — connector as found when
troubleshooting

Mating Jumper —image of patch cord connector
Bulkhead — image of panel-mounted bulkhead
connector

TRM 2.0 reporting software allows user to prepare reports containing paired images

Jobx: JOB00000000D >
Scope End: END100 >
Far End: END200 >
Cable: con>
Pair Mode: Cleaning >
Pair Type: Before >
Fiber: o>




Viewing Saved Results (Results Manager)

Opening Image Files - Reviewing Saved Results

The Results Manager is accessed from the Live Image mode > Main Menu.
« From the Main Menu, use Up/Down % arrow keys to navigate and highlight the Results Manager (&).
— Press Select or Right » arrow key to display a list of existing Job folders.
Use Up/Down % arrow keys to navigate and highlight the desired Job folder (B).
— Press Right » arrow key to open the selected Job folder and display a list of existing Cables.
Use Up/Down % arrow keys to navigate and highlight the desired Cable folder (C).
— Press Right » arrow key to open the selected Cable folder and display a list of existing files.
Use Up/Down % arrow keys to navigate and highlight the desired image File (D).
— Press Right » arrow key to open the selected image File.

o Press Back soft key or Capture key to return to Live Image mode.

Jobs(2) 99% free C001-003
Open p| | Close Openp | Close Open p Fail
{:(i} Settings >
() JOBO00000000 () ENDI00-END200-CO01 [ 001 .
(&) Resuits Manager > (£ JOBODODDOOOT (] END100-END200-C002 31 002
5 003
Last Image > 5] 004
) 51005
Q- =
[ 007
3ob: Iob: JOBUOODO000D| | Job: >
Scope End: Scope End: Scope End: ENDI00
Far End: Far End: Far End: END20D
Cable: Cable: Cable: cool
S =

Creating New Jobs/Cables/Files

New Job, Cable End, Cable, or Fiber names are created in the Captured Image mode by editing an
existing file name. For details see section titled "Saving to a Newly Created Folder” on page 18.

Deleting Jobs/Cables/Files

« Access the Results Manager.

9804p free [
Use the Up/Down 9 keys to navigate and highlight 4 Close Open b
the desired job/cable/file (E). i 001

o] 002
e Press the Menu = soft key. 5 003
o] 00!
« Press the Up/Down ‘% keys to highlight Delete (F). 5 nn;
| 006

« Then press Select (G) to delete the highlighted
job/cable folder or results file.

oo?

Job: COMPAREDDDDD
Enable Multi-Select
Delete

9 Select

20



Sharing Captured Test Results

Uploading Inspection Results to a PC

On FOCIS Flex

« Turn your FOCIS Flex unit off.

« Using the supplied USB cable, connect the micro-USB port on your FOCIS Flex unit with a USB port on
your PC.

« Verify FOCIS Flex powers up and displays:
— Mass Storage
- Video

o Select the Mass Storage mode.

On PC
o Select "My Computer'.

o Verify that device labeled 'PROBE (E:\) appears in My Computer window
Note: drive letter assigned to PROBE device may be different.

Double-click PROBE (E:\) to view contents of the FOCIS Flex internal memory.
Double-click on RESULTS folder.
« Drag, copy, or move some or all of the results to your PC.

When finished, disconnect USB cable and turn off FOCIS Flex (since FOCIS Flex will remain on and
return to normal operation if USB cable simply disconnected.)

Inspection Reporting using TRM® 2.0

On PC

e Install and run TRM 2.0

« Select Report Wizard

« Navigate to uploaded FOCIS Flex Results.

o Select entire [Cable] for all results.

o Select individual fiber for single result.

o Select desired inspection template (2 or 12 results per page).
« Select Finish and print or save as PDF file.
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F AFL Test & Inspection

Thank you for choosing AFL Test & Inspection!

2002/95/EC
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